1996

*Book of Mormon Reference Library (CD-ROM); Book of Mormon Studybase (CD-ROM); LDS Collectors Library 1995 Edition (CD-ROM)*

Alan C. Ashton

Follow this and additional works at: https://scholarsarchive.byu.edu/msr

BYU ScholarsArchive Citation


This Study Aid is brought to you for free and open access by the All Journals at BYU ScholarsArchive. It has been accepted for inclusion in Review of Books on the Book of Mormon 1989–2011 by an authorized editor of BYU ScholarsArchive. For more information, please contact scholarsarchive@byu.edu, ellen_amatangelo@byu.edu.
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Author(s)</td>
<td>Alan C. Ashton</td>
</tr>
<tr>
<td>ISSN</td>
<td>1099-9450 (print), 2168-3123 (online)</td>
</tr>
</tbody>
</table>
The three computer software products, Book of Mormon Reference Library (Reference Library), Book of Mormon Studybase (Studybase), and LDS Collectors Library (Collectors Library) bring volumes of Latter-day Saint writings, including the scriptures, directly to personal computers. In many respects, this is much better than having the books themselves: (1) a CD replaces shelves of books; (2) electronic indexing replaces card catalogues and indexes; (3) clicking in the table of contents or on the scroll

Alan Ashton wrote this review before joining the board of directors at Infobases.

1 The software products run on PC computers (IBM Personal Computer compatible computers) or on the Apple Macintosh computer. On the PC, each of the three products requires a 386 processor or higher, Windows 3.1 or Windows 95, and a double speed CD-ROM drive or higher. The RAM requirement is a minimum of 4 MB (8 MB or higher is recommended) with a minimum of 2 MB hard disk space. The Collectors Library requires a VGA 256-color monitor and video card for viewing the color images and maps and a sound card with speakers for listening to the tutorials and hymns. The Reference Library and the Collectors Library Mac versions require the Mac System 7 operating system.

2 Clicking means positioning the cursor (by moving the mouse) to a designated region on the screen and then pressing the mouse button once or twice.
bar directional arrows or dragging\(^3\) the scroll-bar positioning thumb replaces finding the books, getting them down from the shelves, looking up page numbers in the table of contents, and turning the pages; (4) electronic bookmarks with names replace bookmarks; (5) hypertext links\(^4\) replace cross-references; (6) printing passages of text replaces photocopying; (7) selecting and copying passages of text to a word processor replace typing the passages or scanning them into the computer; (8) selecting text and applying an electronic highlight replace highlighting text with highlighter pens; (9) attaching pop-up notes to paragraphs of text or to verses of scripture replaces writing in the margins of books; and (10) quick location of text passages that contain certain words and phrases replaces long hours of reading and research.

All three products license the Folio Bound VIEWS\(^6\) technology for storing, linking, viewing, searching, and marking the text. This underlying Folio software allows users\(^7\) to read the texts, create and follow hypertext links, search for words and phrases, go from table of contents and index entries directly to the text, and mark the text. Users can find items of text (such as passages of scriptures, excerpts from books, and quotations) with the powerful

---

\(^3\) Dragging means moving the mouse while keeping the left mouse button depressed.

\(^4\) A hypertext link is a mechanism that allows a segment of text (the link) such as a character, a word, or a phrase to be linked to another place in the text called the destination. The link is shown in a different color to make it obvious, and the mouse cursor is displayed as a hand rather than a vertical line or pointer when it is on such a link. Double clicking on a link causes the text at the destination to be displayed on the screen.

\(^5\) Selecting, or blocking, text is accomplished by dragging the mouse pointer over the desired text.

\(^6\) For a review of the Folio VIEWS software see Yael Li-Ron, *PC Computing* (January 1995): 100. Folio VIEWS is called “A Database and Then Some” and received four out of five stars, indicating it is a very good software product. Folio VIEWS 3.1 Infobase Manager won *PC Magazine’s* Editors’ Choice award, 7 February 1995. Folio Corporation is located at 5072 N. 300 W., Provo, Utah 84604; telephone: (801) 229-6700.

\(^7\) User is a term in computer jargon that designates people or customers using a software product. I would prefer to say people who are using the software product, but that is too verbose for repetitive use.
computer-assisted searching operations that allow searching of text by author, title, subject, and content.

In this review I will discuss the use of these products, their content, their similarities, their differences, and finally my recommendations. This review concentrates primarily on the Windows versions of the three products even though Macintosh (Mac) versions of the Reference Library and the Collectors Library are also available.

Who Would Want to Use These Products and Why?

Because of their ease of use and the extensive content of Latter-day Saint writings, anyone wanting to become more well-versed in the scriptures and in Mormon doctrine would enjoy using these products. These libraries are ideally suited and, I think,

8 When I brought up the Reference Library on the Mac, I immediately found a couple of problems. The instructions in the manual said to double click on the reference library icon rather than double clicking on the install icon. Once I had the program installed, I tried to go to Help from the pull-down menu, but it came back with an error. I was able to run the help file by directly clicking on it from the display of the CD-ROM contents, but not from the program. Then when I tried to select some text to test copy to a word processor, I found that the Copy command did not even appear on the Edit menu. A Mac user would certainly expect to use the Copy command to copy information to a word processor. I was able to export text to a file by tagging passages and using the SaveAs command. I called technical support about the problems; they were aware of them and said that a new version that would correct the problem was in production. They told me how to bypass the problems in the meantime. They said I could merely change Preferences (under the File menu) from Personalize to Full in order to see and use the Copy command.

9 See the review by Larry K. Smith, “LDS Collectors Edition CD-ROM,” Review of Books on the Book of Mormon 7/2 (1995): 256–63. When I brought up the Collectors Library on the Mac, it worked very well for me. I played background music, copied selected text to a word processor, performed several searches, looked at images and maps, and ran a tutorial. The tutorial contained a spoken explanation along with the moving mouse pointer on the screen, making it very clear how to perform the particular operation. Folio, at the encouragement and with help from the programming team at Infobases, has made the VIEWS operation much more Mac-like than in the past. Rather than the + and - symbols to indicate a nonexpanded level of a table of contents entry and an expanded level, respectively, the common Mac triangle symbols are used. Improvements have also been done to allow Mac-like single clicking in many cases rather than the double clicking required in the Windows version.
indispensable for doctrinal research, historical research, finding answers to gospel questions, preparing talks and lessons, providing interesting reading, understanding gospel principles more fully, satisfying curiosity, understanding the teachings of a particular Latter-day Saint leader, seeing consistency in the scriptures, and establishing a study base of the scriptures and gospel topics.

A major application of these products is finding passages of text and copying them into a word-processing document. From there the information can be printed and distributed or used in a lesson outline or talk. Although it would be nice to have the texts of these three products in a single library, at least they are represented in a common format. Because of this, with some care, swapping of CDs is possible, allowing each product to access texts of the other products. This will likely continue to work as long as the products use the same infobase format.

I had hoped it would be possible to open these products simultaneously as separate Windows applications and then jump back and forth with the switching capabilities of the Windows applications, but that didn’t work. When I tried it, the products malfunctioned and crashed. To be on the safe side, users can run one of the products and then close it down and run another one, all the while having a word processor open. In this way, text from the different products can be easily and safely gathered into a word-processing document, but extra space is required on the hard disk to house the multiple products. The minimum 4 MB of

---

10 I spent considerable time experimenting to see if I could access texts of all the products from a single product. I could not indiscriminately swap CDs back and forth. I had hoped that the software was sophisticated enough to tell me when to put in the appropriate CD, but it wasn’t. I opened the multiple Folio infobases (.nfo and .sdw files) by use of the Open command (on the File menu). I could open .nfo files on the Collectors Library and Studybase CDs with all the products, but I had to open the .sdw files (shadow files found on the hard disk in the Reference Library directory) in order to access the Reference Library CD from the Collectors Library or Studybase. I used the list of currently open windows shown under the Windows menu to jump from one infobase to another, but I had to be careful to have the appropriate CD in the drive as I did so. I found it was best to leave all the windows open during the session and then close them all with the Close All command (on the Windows menu), with the original CD in the drive at the end. For safety, I often saved my word-processing document to disk and did so always before exiting the Folio software.
RAM would not be adequate to cope with this kind of multi-tasking.

Consistent with Brigham Young's plea that truths from all places pertaining to life and salvation be gathered to Zion,\footnote{“Gather up all the truths in the world pertaining to life and salvation, to the Gospel we preach, to mechanism[s] of every kind, to the sciences, and to philosophy, wherever [they] may be found in every nation, kindred, tongue, and people, and bring it to Zion.” Brigham Young, 9 October 1859, in \textit{JD} 7:283–84. I used the three software products to see in how many places I could find this quotation. The \textit{LDS Collectors Library} contained four occurrences. In addition to the one cited in \textit{Journal of Discourses} it is also quoted in the \textit{Discourses of Brigham Young}, comp. John A. Widtsoe (Salt Lake City: Deseret Book, 1978), 248; Eliot A. Butler and Neal E. Lambert, “Brigham Young University,” in \textit{Encyclopedia of Mormonism}, ed. Daniel H. Ludlow (New York: Macmillan, 1992), 1:221; and in Hugh Nibley, “Educating the Saints—A Brigham Young Mosaic,” \textit{BYU Studies} 11/1 (Autumn 1970): 68. The Book of Mormon Reference Library contained one reference, found in \textit{Discourses of Brigham Young}, 248, and the \textit{Book of Mormon Studybase} contained no references to this quotation.} these products accomplish the gathering of much published information, especially concerning the Book of Mormon, in a common digital format.

**Content of the Products**

The \textit{Reference Library} includes thirty-five works\footnote{For the names of the authors of these individual publications (which I have not included because the list is so long), refer to the products themselves or to the product literature. These lists of books are meant to show the overlap and general scope of publications contained in the products.} (items marked with an asterisk on the box are FARMS publications): the standard works (King James version of the Bible [KJV], Book of Mormon, Doctrine and Covenants, and Pearl of Great Price), the RLDS Joseph Smith Translation of the Bible (JST), \textit{An Approach to the Book of Mormon*}, \textit{Discourses of Brigham Young}, \textit{Gospel Doctrine}, \textit{Lehi in the Desert*}, \textit{A New Witness for the Articles of Faith, The Prophetic Book of Mormon*}, \textit{Since Cumorah*}, \textit{Teachings of the Prophet Joseph Smith}, \textit{A Topical Guide to the Scriptures of The Church of Jesus Christ of Latter-day Saints} (1977), \textit{The World of the Jaredites*}, \textit{There Were Jaredites*}, \textit{Answers to Gospel Questions} (4 vols.) (the items mentioned so far in this list are also contained in the \textit{Collectors Library}), \textit{Answers to}

Studybase includes twenty books in addition to the Latter-day Saint standard works. It does not include the JST. With the exception of Mormon Doctrine (which is also in the Collectors Library), the other titles in Studybase are unique: Mormon Doctrine, Doctrinal Commentary on the Book of Mormon (4 vols.), Book of Mormon Compendium, A Book of Mormon Treasury (selections from the Improvement Era), The Most Correct Book, The Book of Mormon: Key to Conversion,14 Building Faith with the Book of Mormon, and the BYU Religious Studies Center publications: The Book of Mormon: The Keystone Scripture, First Nephi—The Doctrinal Foundation, Second Nephi—The Doctrinal Structure, Jacob through Words of Mormon—to Learn with Joy, Mosiah—Salvation Only through Christ, Alma—The Testimony of the Word, Helaman through 3 Nephi 8—According to Thy Word,

13 This tape, a $13.95 retail value, contains an overview of the Book of Mormon, including its history, authors, plates, prophets, writers, witnesses, doctrines, and purposes. The content is well worth listening to, but the recording was somewhat difficult to understand because it was not recorded in a soundproof recording chamber but echoed as though it was recorded in a lecture hall. It was a bit disturbing to hear sections of static and silence on the tape where portions of the lecture were missing. It would be nice to have this lecture available in the text of the Reference Library product. See the review by Kay Edwards in Review of Books on the Book of Mormon 8/1 (1996): 168–71.

14 This book, The Book of Mormon: Key to Conversion by Glenn L. Pearson, is missing from the list of books on the product package.
3 Nephi 9–30—This Is My Gospel, Fourth Nephi through Moroni—From Zion to Destruction; and Book of Mormon Authorship: New Light on Ancient Origins.

Studybase includes a utility software program called Lesson Planner/Talk Writer, which consists of a lesson outliner and simple word processor. Additions to the Toolbelt enhance the product. In Studybase it is convenient and simple to go back and forth between Studybase and Talk Writer, taking passages from the Studybase library to Talk Writer.

Infobases’ Collectors Library is the most mature and extensive library of these three products. It includes a total of 818 works. These works include the standard works, the JST, a Hebrew and Greek Bible lexicon, doctrinal works by presidents of the Church, 270 books and 2 pamphlets written mostly by apostles, 15 volumes of Church histories, 13 volumes of early LDS periodicals, 70 issues of BYU Studies, plus 72 books, 13 pamphlets, 143 volumes of Latter-day Saint biography and family history, and 56 volumes of Susan Easton Black’s early membership ordinance data. All the presidents of the Church from Joseph Smith to Gordon B. Hinckley are represented with important works on Latter-day Saint doctrine, including speeches by Howard W. Hunter and Gordon B. Hinckley. The Collectors Library includes links to every speech in the library given by these two prophets. Significant works such as Teachings of Ezra Taft Benson, Teachings of Spencer W. Kimball, Faith Precedes the Miracle, and The Miracle of Forgiveness are included. The following classic doctrinal works are also found in the Collectors

---

15 The Toolbelt is the Folio button bar. Each button corresponds to a Folio function that is executed when the button is clicked. Users can customize the Toolbelt by deleting and adding functions.

16 See reviews by Smith, “LDS Collectors Edition CD-ROM,” 256–63, and Gail A. Newbold, “Gospel Knowledge on CD,” This People (Fall 1993): 26–32. In the latter review, the name of Infobases’ president, Daniel Taggart, is mistakenly spelled “Tagger.”

17 Private communication from Andrew Ehat, vice president of research for Infobases. The 818 number counts each issue of early LDS periodicals as a work. The Collectors Library packaging indicates 804 works, but a more careful counting since then has revealed 818 items.

18 Susan Easton Black, Membership of the Church of Jesus Christ of Latter-day Saints (Provo, Utah: BYU Religious Studies Center, 1989).
Library: Messages of the First Presidency, Doctrines of Salvation, Mormon Doctrine, Doctrinal New Testament Commentary, Articles of Faith, Jesus the Christ, The Promised Messiah, The Mortal Messiah, The Millennial Messiah, A Marvelous Work and a Wonder, Teachings of the Prophet Joseph Smith, Discourses of Brigham Young, Journal of Discourses, Mediation and Atonement, Gospel Kingdom, Gospel Doctrine, Sharing the Gospel with Others, Gospel Ideals, and The House of the Lord. Every general conference address from 1899 to 1970 is included, along with BYU Speeches of the Year given in forums and devotionals from 1960 to 1965. I am looking forward to the time when more recent conference addresses and BYU speeches become available. The Encyclopedia of Mormonism is also included in the Collectors Library. Infobases has purchased exclusive electronic rights to The Encyclopedia of Mormonism and is planning to publish any future additions made to this encyclopedia to keep it current.

The Collectors Library also contains 22 maps of Bible lands, the complete Historical Atlas of Mormonism with over eighty maps detailing the history and growth of the Church in the latter days, more than one thousand digitized photographs, and pictures of LDS Church leaders, temples, scenes from the Holy Land, LDS Church history sites, Central and South American lands, early Saints, and other LDS people, places, and things. Finally, the Collectors Library also includes the text and music of 285 LDS hymns.

As a bonus for registering, the Collectors Library also includes sixty-nine volumes of American history, the 1994 World Factbook, and over 12,000 famous quotes.

**Similarities**

Because the three products use the common Folio VIEWS software, standard functions and similar operations appear in each product. Each supplies richly cross-referenced (hypertext-linked) text. Each shares the powerful searching capabilities of the Folio

---

19 The searching power comes from the following internal organization of information in the software. A large dictionary of all the words in the text is built with pointers (paragraph or verse numbers) to the places where each word
technology. When a search operation is performed, the paragraphs containing the searched-for items are called hits. Users can choose to see where the hits occur in the text itself or in the table of contents. Searches can be performed in the entire library, in all opened libraries, in the scriptures only, in a group of books, or within a single book. Searches can be done by scriptural reference, and they can be done within personal notes or within just those passages which have been highlighted by a certain highlighter.

Toolbelt buttons are provided in each product for commonly used operations, such as switching back and forth between the table of contents and the text, switching back and forth between the display of only the hits or the entire text, going forward or backward in the text to the next or previous hit, viewing or not viewing the reference information with each paragraph, and backtracking to the previous places in the text from where links were followed.

All three products allow the creation and use of multiple copies of the libraries. That means that family members can have their own individual copies of the libraries. In their personal copies users can (1) put bookmarks in the text for immediate access to user-specified places, (2) attach personal notes to passages in the text, (3) establish links from one part of the text to any other, and (4) group passages of text together, for example, by highlighting related portions of text with user-defined highlighters.

---

occurs in the text. If a search is done, for example, for the places in the text where the words *charity* and *mercy* both occur, the program goes to the dictionary entry for *charity* and compares the pointers with those of the entry for *mercy*; entries that match are kept. The locations of these matches are called hits. The comparison usually happens within seconds.

20 For each individual "copy" a shadow file (.sdw extension) is created and associated with the main library. This shadow file contains the added user information, with pointers into the unaltered main library indicating where the information is associated. This customizes the way the CD-ROM is accessed for each individual.

21 A *highlighter* consists of a name and text-display attributes. Users may create highlighter names and specify the color and font to be applied to the highlighted text.
Searches using the common Boolean operators—*and*, *or* and *not*—can be composed to find an infinite variety of associations in the text. For example one might want to know which scriptural verses contain the words *Lord* and *praise*, without the words *music* or *song*. Searches can be done for synonym groups of words. For example the search for *beaut* $ (the dollar sign signifies a thesaurus search) finds occurrences of words such as *beauty*, *grace*, *goddess*, *comeliness*, and *magnificence*. Stem searches can also be done. For example, *sing*% finds the words *sing*, *sang*, *sung*, and *singing*. Stem and thesaurus searches can be combined with the Boolean operators. Exact matches of text phrases (phrases designated within quotation marks) can also be done.

Each of the three products contains links from scriptural references in the writings to the scriptures. These cross-reference links allow the user to double click on a scriptural reference while reading in the writings and to be taken directly to the scriptures at the point of the reference. After jumping to the scriptures, the user can use the Backtrack button on the Toolbelt to get back to the writings.

The instruction manuals for the products are small pamphlets. Each product relies upon online Help documentation, which is in Folio VIEWS format. Of course the operations and search capabilities of the underlying Folio software can be used to find relevant information quickly in the hypertext-linked Help info-bases. Assistance can also be obtained by calling technical support. For each product, I found the technical support personnel to be knowledgeable and competent. They answered all my questions in a timely manner.

With each of the products, I recommend using the following sequence for copying information from the libraries to a word processor. This describes the operation in the Windows environment, but it works similarly in System 7 on the Mac. Cycle back and forth between the infobase and the word processor with the

---

22 This search could be done by the following query: *lord* *and* *praise* *and* *not* (*music* or *song*) or more easily by: *lord* *praise* *wul* (*music* or *song*).

23 Exact phrase searches take more processing time because after the matches containing all the words of the phrase have been quickly found from the dictionary entries, the actual text paragraphs must be accessed and sequentially scanned to see if the exact phrase is present.
Windows Alt-Tab\textsuperscript{24} function. This Alt-Tab function can be used initially to switch to the Windows Program Manager where the word processor can be opened. The following simple repetitive sequence copies passages from the library to the word processor: cycle (Alt-Tab function) to the library and there select the appropriate passage (by dragging the mouse over the text) and then type Ctrl-C (same as the Copy command on the Edit menu) to put the passage in the Windows clipboard; then cycle to the word processor and type Ctrl-V (same as the Paste function on the Edit menu) to insert the passage into the word-processor text at the point of the cursor.

Differences and Comparisons

The three products differ mainly in the writings and in the cross-references (number of links) included. I will consider each product in turn.

Book of Mormon Studybase

\textit{Studybase} includes the scriptures, but no JST and no linking from the scriptures to anything else. The other two products have extensive cross-references from the scriptures and link scriptures together by topics.\textsuperscript{25} \textit{Studybase} has a button on the Toolbelt that conveniently shows two windows side by side, one which displays the writings and the other which displays the scriptures. In \textit{Studybase} the Toolbelt is enhanced with more buttons than in the other two products. These buttons are small and do not include identification text; however, as the mouse pointer moves across these buttons, a "balloon prompt" is shown giving the name of the button.\textsuperscript{26} If it becomes annoying, the balloon help can be

\textsuperscript{24} To use this function, hold down the keyboard Alt key and repetitively strike the Tab key until the desired program name is shown on the screen. Then lift up on the Alt key to jump to that program.

\textsuperscript{25} The Group function is used by the other products to group scriptures by topics. \textit{Studybase} allows the Group function to be used; however, no previously defined Groups are part of the program.

\textsuperscript{26} These balloon prompts could have been programmed to be context sensitive to show the state of the program, but they were not. For example, the
The modified Toolbelt in Studybase has a Search/Query Box convenient for doing quick searches. The user merely types the query in the box and clicks on the nearby "Search (F2)" button. The user can also click the arrow box next to this Search/Query Box to see previous searches, even those done at an earlier session.27 Clicking on any previous search string puts it in the Search/Query Box and makes it the current search.

The Studybase Toolbelt allows three quick temporary bookmarks. Using these buttons is simple: click with the left mouse button to set the bookmark, and click with the right mouse button to go to the place of the bookmark. This is convenient for temporarily keeping track of three places in the library text. The modified Toolbelt also has some buttons to aid the user in navigating through the text (to go to the beginning or end of text, for example); however, these functions can easily be performed in all the products by dragging the thumb of the scroll bar. Dragging the thumb to the top or bottom immediately jumps the user to the beginning or end of the text.

Studybase allows user modification of the text inside the program, rather than after copying to a word processor, whereas the other products do not. I much prefer the latter, because it is possible to type characters or delete characters accidentally while researching text. To allow the text to be changed by inadvertent key strokes is not a good idea. The feature allows the correction of errors in the text, but it also allows the rewriting of scripture. Fortunately, the modifications are only stored in a shadow file, so by getting rid of the shadow file the original version of the text can always be restored.

Studybase includes the Lesson Planner/Talk Writer program. I spent some time learning to use this utility to see how easily it could be used with the libraries of all three products. It required some experimentation to see how the outliner and word processor

prompt for the "Records with Hits" button is the same whether the full text or just the text of the hits is being displayed.

27 In all products, search strings used previously in the current session can be accessed by clicking the Up-Arrow and Down-Arrow boxes in the query entry screen.
work because there was so little documentation. The outliner facilitates the simple creation of a hierarchical outline. Each level can be easily expanded or condensed with a single mouse button click. Clicking on an entry in the outline opens that element in the word processor. In Talk Writer the user clicks on the button named Research to go to the Studybase library. There, the user clicks on the Toolbelt Talk button to go back to Talk Writer. To add passages of text from the library to Talk Writer, the user first selects the pertinent text, clicks on the Talk button and then clicks on the Insert button in Talk Writer. It is simple to go back and forth, selecting passages in the Studybase library and then inserting the passages into the appropriate sections of the talk in Talk Writer. This same sequence does not work with the libraries of

---

28 Although there were prompts to follow from the Wizard, I had to experiment to determine how things were supposed to work. There was little information concerning how this product worked in the printed documentation. I was disappointed not to find online documentation, even in a Folio infobase. Prompts by the Wizard technology got me started, and balloon prompt messages indicated the function of each button or menu item on the screen. It wasn’t apparent to me at first that I should type an entry in the typing field in order to have that entry added to the list in the outline window below. (I unsuccessfully tried to type directly in the outline box.) Once I found out where to type and saw that the control buttons allowed me to manipulate the selected entry in the outline window up and down and back and forth between hierarchical levels, it was simple to create an outline with nested section headings. Once I “finished” doing the outline, I didn’t know how to begin. I clicked on the folder icon next to the outline section headings rather than on the headings themselves. Another mistake I made was to double click on the control corner of the outline box to hide it. Then I went to the View menu to Show Outline, and I got a blank outline box rather than the one I had created and expected to see. I also didn’t know until further experimentation that I needed to close the word-processing screen in order to have the Wizard selection available on the File menu. Once the Wizard selection was available, I was able to retrieve my outline.

29 A single click is Mac-like and is the way that Table of Contents level expansions and contractions work in the Mac versions of Studybase and the Collectors Library. In the Windows version of File Manager, for example, and in the Table of Contents, a double click of the mouse button is standard to obtain expansions and contractions in the three products. I found myself automatically double clicking in the Mac versions to expand a level in the outline, only to find that nothing was accomplished because, with the toggle feature, one click caused expansion and the next contraction.
other products; however, the procedure outlined above for copying text from the libraries to a word processor works as well for Talk Writer.

Although the Lesson Planner/Talk Writer program is a nice addition to the *Studybase* product, a user likely has a favorite and familiar word processor. Full word processors, such as WordPerfect or Microsoft Word, which allow footnoting and other advanced word-processing functions, are just as easy to use in copying passages from libraries. Users may also just as easily use the simple word-processing program Write, which comes with Windows (in the Accessories group).

*Studybase* has tutorials that consist of instructions to be read and running demonstrations. In these tutorials, operations are performed automatically, and the user can see pretty well what to do and how the operations work. *Studybase* allows its CD libraries (.info files) to be copied to and used from a hard disk; thus other products can safely use these libraries without switching to the *Studybase* CD.

**Book of Mormon Reference Library**

The *Reference Library* contains more links than *Studybase*. Each verse of the scriptures is linked to the topical guide, to topical groups which contain that scripture, and to locations in the writings which reference that scripture. It is like having several commentaries on the verses of the scriptures. All the references for each topic in *A Topical Guide to the Scriptures of The Church of Jesus Christ of Latter-day Saints, 1977 edition*, are linked together. A double click on a topic or subject heading in the Comprehensive Subject List brings up all the scriptures belonging to that topic. A user can also search the text according to author. The *Reference Library* encourages users to group text passages only with the use of the highlighter method.

---

30 To jump back and forth between Talk Writer and a library other than *Studybase*, I found that I could not use the Research and Insert buttons in Talk Writer nor the Talk button in *Studybase*. Instead I used Copy and Paste functions and the normal Windows functions to switch between the two programs.

31 The Folio software has a Group function for grouping passages of text together. This Group function is used to implement the topical guide, but in the
The entire Joseph Smith Translation of the Holy Scriptures as published by the Reorganized Church of Jesus Christ of Latter Day Saints is contained in the *Reference Library*. With the entire text, it is difficult to find Joseph Smith’s modifications easily. Some links work from the KJV to the JST, but none from the JST to the KJV. The user can find some of the changes Joseph Smith made in the Bible by following the links to the JST, but in order to see the KJV text along side the JST text, the user must open (Open command on the File menu) another copy of the library and then display the windows side by side (Tile Vertically command on the Windows menu). This does not happen automatically (as it does in the *Collectors Library*) and few links exist (compared to the *Collectors Library*), making synchronization and comparison of the JST and the KJV quite laborious.

The *Reference Library* contains a number of classic quotations on the Book of Mormon. At the beginning of these, the user is told to press the Contents button for a list of topics, but in reality, this action produces a list of authors, not topics. Compared with the other products the *Reference Library* contains the least amount of instruction in the printed user’s manual concerning how to take passages from the libraries and assemble them for a talk.  

---

At first I thought there were no links from the KJV to the JST in the *Reference Library* because at the beginning of Genesis, where major differences exist, I found no links. However, I compared the number of verses in Matthew 27 (chapter chosen at random) linked to the JST: the *Reference Library* contained only four links (i.e., only four verses in the KJV were linked to JST verses), and the *Collectors Library* contained thirty-four links! Two of the thirty-four links could perhaps be discounted because the text in both versions was the same (with different paragraphing), but the rest of them pointed to specific differences in the versions.

The only mention of this is in the last sentence of the manual. It is in the “Tagging Text” section, which reads, “You can now print them [paragraphs which have been tagged and ‘kept’] out, block and copy them, save them to another file, and so on.” That is not much explanation to go on. An incorrect inference that a novice user might make is the assumption that, in order to save passages to a file, tagging must first be done. However, the procedure discussed in this section of the manual—to tag various passages, to “keep” them, and then to “block and copy” them—is a convenient way to assemble passages for copying to a word processor. The term *block* is not defined (that function is more
The Reference Library does not allow the use of its libraries on a hard drive; the other products do. I wanted to copy the libraries (.nfo files) onto my hard drive so that I could test accessing them with the other products. I was disappointed to see a message indicating that the Deseret Software product did not allow access to the text except from a local CD drive. That means the user can’t even copy the files to the hard disk of a laptop computer and use the program without a CD drive. It also means a user can’t have a copy of the writings of the Reference Library on a hard drive for convenient access by the Collectors Library or Studybase. The alternative, to swap CDs, is awkward and can be dangerous. The technical support personnel at Deseret Software said that they were changing this policy for future releases of their infobase products. I recommend only getting releases which do not have the restricted CD-ROM access.

**LDS Collectors Library**

The Collectors Library has the largest content by far and the most extensive cross-referencing. Their two and a half million links implement the following capabilities: (1) Each word in the Bible is linked to entries in a Hebrew/Greek lexicon, (2) each KJV verse different from the JST is linked to the JST verse, (3) each scriptural reference in the writings is linked to the scriptures at the place of the reference, (4) each verse in the standard works is linked to the appropriate topical list, (5) each author is linked to the author’s writings, (6) each topic (including the topics of the topical guide used in the Reference Library) is linked to the scriptures and to the passages belonging to the topic, and (7) all the locations containing a reference to a particular scripture are linked together. These capabilities provide extensive commentary on scripture verses.

The JST text in the Collectors Library contains only the verses that differ from those in the KJV. This implementation is convenient for identifying the changes Joseph Smith made to the Bible, a task difficult to do even with our published Latter-day Saint scriptures, in which the larger JST passages are all together often referred to in the literature as *select*. Blocking or selecting text is accomplished by dragging the mouse cursor across the desired text.
in the back, but the smaller changes are dispersed in footnotes throughout the Bible.

An additional advantage in the Collectors Library is the Auto Compare feature. This capability splits the screen when a link is followed from a verse in the KJV to the corresponding verse in the JST. Thus both scriptures can be seen and compared side by side. It is unfortunate that no links go in the other direction (from the JST verses to the corresponding KJV verses).

The Auto Compare feature has other advantages. Having the automatic side-by-side windows is convenient in the following two situations: looking up Hebrew and Greek forms of words, and jumping from scriptural references in writings to the scriptures themselves. In the first case, one window shows the scriptures and the other window shows the definitions of the original Hebrew or Greek word. In the second case one window shows the writings (containing the scriptural reference) and the other shows the scriptures. The Auto Compare feature can be turned on or off at any time.

In the Collectors Library, users can add scriptures or passages to existing topical groups and can also make new groups, which can be searched by the topical search. The Collectors Library allows the user to search for passages according to topic or author, and as the user types the topic or author's name, the topics or authors are displayed. The display of this list changes as the user types, showing the allowable topics and authors with the next one (in alphabetical order) highlighted.

The Collectors Library pamphlet is especially useful because it emphasizes those operations most frequently used. It starts out with a description of how to prepare a talk. It includes instructions for assembling passages of text into a word-processing document. The Collectors Library has the best and most extensive online documentation and tutorials. In addition to a complete infobase, which describes the operation and features of the Collectors Library product, many running demonstrations are also available. These running demos contain spoken explanations, along with the execution of the features. The movement of the mouse pointer on the screen is shown in slow motion. It is like having someone by your side speaking about and demonstrating the product. These tutorials are very helpful and nicely done.
The Collectors Library is the only product to include the text and music of Church hymns. Words of the hymns can be displayed on the screen as they are being played. Hymns can also be played in the background while the Collectors Library is being used.\textsuperscript{34} By the use of portable laptop computers with sound cards and small speakers, Saints can easily take the music of the Church hymns to congregations all around the world.

**Recommendations**

Each product is well worth the cost for the library contents alone, not to mention the search and text-marking functions, and, in the case of Studybase, the Lesson Planner/Talk Writer utility. The purchase cost for all the printed textual materials (books, magazines, pamphlets, and so forth) contained in the Collectors Library would be over $10,000,\textsuperscript{35} for those in the Reference Library over $550, and for those in Studybase over $234. Given the purchase price of $99.95 for the Collectors Library with 818 works, the average price per work is only 12 cents. Given the purchase price of $49.95 for the Reference Library with 35 works, the average price per book is only $1.43, and given the purchase price of $39.95 for Studybase with 24 works, the average price per book is only $1.66.

I recommend having all three products in your computer library\textsuperscript{36} because of the wealth of information at such a low cost and because some of the material in each product is out of print. If purchasing only one product is possible, I recommend that the choice be based upon the content of the libraries. If the choice is for value, the greatest content, or general research in Latter-day Saint writings and doctrine, I recommend the Collectors Library product. If recent FARMS books on the Book of Mormon are the deciding factor, the Reference Library is the product to buy

\textsuperscript{34} By selecting the appropriate option on the Study Aids menu I started the background playing of hymns and listened to the digital organ-like music while I prepared part of this review.

\textsuperscript{35} Private conversation with Daniel D. Taggart, president of Infobases, April 1996.

\textsuperscript{36} All three products are available for Windows users and two for Mac users.
(although the FARMS periodicals are in the Collectors Library). If the BYU Religious Studies materials on the Book of Mormon and the Lesson Planner/Talk Writer program are critical, the Studybase product is the one to purchase.

Although the computer is not yet the ideal substitute for books, computers are becoming more and more universally accepted. It is not uncommon now to see students taking notes in school classes on portable laptop computers. These now can support a CD-ROM drive, so the libraries of these infobase products are easily portable. Computers will become more attractive as substitutes for books as the following technological advances are made: (1) vast amounts of information will become digitally available in databases and textbases (such as infobases); (2) computers will become smaller, faster, less expensive, and more portable; (3) the quality of the screen display will increase in sharpness, producing text that is easier to read and higher quality pictures; (4) computers will become more widely used for everyday communication; (5) computers will be hooked up to networks, which will be the source of libraries of information, and (6) increasingly more information will be available only in digital format. The downside is the constant upgrading of hardware and software, rendering existing products obsolete.

Deseret Software has other Folio VIEWS-based products, including The Savior and His Gospel Reference Library ($79.95) and Women and the Gospel Library ($49.95). Infobases Corporation has a number of other Folio VIEWS-based products, including an exciting new product called The LDS Family History Suite which has a $69.95 introductory price. Readers who are interested in genealogy and family history will want to take a good look at this product.

As I was doing this review I was easily entertained as I spent much time following links, making new associations, finding interesting doctrinal discourses, and having a lot of fun in general using these three products. They are a valuable aid for computer users studying the gospel of Jesus Christ both casually and seriously. In my mind they justify the purchase of a computer for their use.